
Maximize the Power

of Office 2007

The various applications in Microsoft Office
2007 — in particular, Word, Excel, PowerPoint,
Access, and Outlook — share a common look
and feel. Indeed, you can find many of the
same features in each program, such as the
new Ribbon feature, the Quick Access toolbar,
various program window controls, and the new
Office menu.

This common look and feel is helpful when you
perform certain tasks within Office applications.
For example, creating a new document in Word
is similar to creating a new document in Excel.

The same goes for more complicated tasks,
such as encrypting documents, tracking
changes to a document, adding a digital
signature, marking a document as final, and
so on. This commonality makes mastering
Office 2007 a snap.

This chapter focuses on tasks that transcend
applications. That is, these tasks can be
performed in more than one Office program.
Although some of these tasks do apply to
Access and Outlook, most relate only to Word,
Excel, and PowerPoint.
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1 With the document you want
to make backward compatible
open, click the Office button.

Make a document
BACKWARD COMPATIBLE

By default, documents you create with Office 2007
are saved with an x at the end of the file
extension — for example, .docx, .xlsx, and so on.
Documents with this type of file extension can be
opened and read only by others who also use 
Office 2007. 

If you frequently share documents with others who
use earlier versions of the software suite, you can
save the documents you create in Office 2007 in
Compatibility Mode — a format that is compatible

with earlier versions of Office (or, in other words, a
format that is backward compatible). Documents
saved in Compatibility Mode can be opened and read
by people who use earlier versions of the software.
Documents in compatibility mode do not include the
x at the end of the file extension.

Be aware that saving a document in Compatibility
Mode means that those functions of Office 2007 that
are not supported by earlier versions of Office are
disabled.

11

33

22

The Office menu opens.

2 Click here.

3 Click Word 97–2003 Document.

Note: In this case, Word 97–2003
Document is chosen because a
Word document serves as the
example in this task. If you are
saving another type of document,
such as an Excel document, the
precise verbiage will differ.

4
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The Save As dialog box
opens.

4 Locate and select the
folder in which you
want to save the
backward-compatible
document.

5 Type a name for the
document.

l Notice that the file type
listed in the Save as
type field is Word
97–2003 Document.

6 Click Save.

44

55

66

5

l The document is saved in Compatibility
Mode, as denoted in the application
window’s title bar.

Chapter 1: Maximize the Power of Office 2007

Did You Know?
You can set up the various programs in Office to
automatically save documents in Compatibility Mode.
To do so, click the Office button and then click the
Program Name Options button at the bottom of the
menu. In the window that appears, click Save, click
the Save files in this format drop-down arrow, select
the desired format, and click OK.

03_118702 ch01.qxp  10/31/07  6:04 PM  Page 5



1 With the document you want to
save as a Web page open, click
the Office button.

Save Office documents as 
WEB PAGES

If you have access to a Web server, you can share
your Office documents by saving them as Web pages.
In this way, you can share your Office files with
others who do not use Office.

When you save an Office document as a Web page,
Office converts the document to a hypertext markup
language (HTML) file. This file contains all the
necessary coding to be displayed by a Web browser
such as Internet Explorer 7.

Of course, simply saving an Office file as an HTML
document is not enough to share it with others online.
You will also need to upload the HTML file to a Web
server. That requires using a Web host. You might
have access to Web-hosting services through your
Internet service provider; contact your provider to
find out. If not, you can sign up with a Web-hosting
service to place your HTML pages online. For specific
instructions on uploading your Office documents to
the Internet, consult with your provider.

11

33

22

The Office menu opens.

2 Click here.

3 Click Other Formats.

6
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The Save As dialog box
opens.

4 Locate and select the
folder in which you
want to save the Web
page.

5 Type a name for the
Web page.

6 Click here and select
Web Page (*.htm,
*.html) from the list
that appears.

7 Click Save.
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l The document is saved as a Web page.

Chapter 1: Maximize the Power of Office 2007

Try This!
You can change the title of the page 
— that is, the name of the page as it
appears in the Web browser’s title bar
when the page is displayed. To do so,
click Change Title in the Save As dialog
box. Then, in the Set Page Title dialog
box that appears, type the desired title
and click OK.

Did You Know?
If you have access to a document
management server, you can publish
your Office document to that server.
To do so, click the Office button,
click Publish, and click Document
Management Server. In the dialog box
that appears, locate and select the
folder on the document management
server in which you want to save the
document and click Save.
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1 Click the Developer tab in the
Ribbon.

2 In the Code group, click Record
Macro.

Automate Office tasks with 
MACROS

If you frequently use an Office program to complete
the same task — for example, to format the cells in a
spreadsheet a certain way, or to insert a table in a
Word document that contains a certain number of
rows and columns (as shown here) — you can
expedite the process by recording a macro. When
you record a macro, you essentially record a series of
actions. Then, you can run the macro you recorded
to automatically perform the recorded actions.

One way to access the controls for recording a macro
is from the Developer tab on the Ribbon. This tab is

not displayed by default, however. To display the
Developer tab, click the Office button, click Program

Name Options, click Popular, and click the Show
Developer Tab in the Ribbon check box to select it.

Note that recording a macro in Access differs
somewhat from recording macros in other Office
programs, such as Word, Excel, and PowerPoint. For
information on creating macros in Access, see
Chapter 8.

11
22

33

44
55

66

The Record Macro dialog box
opens.

3 Type a name for the macro.

4 Click here and select the
template(s) in which you want
the macro to be available.

5 Type a description of the macro.

6 Click OK. 

Your mouse pointer changes to a
pointer with a cassette tape icon.

8
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7 Perform the actions you
want to record.

In this example I
inserted a table with 3
columns and 125 rows.

77

88
99

9

8 Click the Developer tab.

9 Click Stop Recording.

Excel saves the macro.
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Apply It!
To run a macro you have recorded, click the
Developer tab and click Macros in the Code group. In
the Macros dialog box that appears, click the macro
you want to run, and then click Run.

Attention!
Because macros can be created for malicious
purposes, they are often disabled by default. To
enable the use of macros in a particular document,
click the Office button, click Program Name Options,
click Trust Center, click Trust Center Settings, and
then click Macro Settings. Finally, click Disable all
macros with notification. That way, when Office
encounters a document that contains macros, it will
display a security dialog box that enables you to
specify whether the macros should be allowed.
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1 With the document whose
properties you want to set open,
click the Office button.

The Office menu opens.

2 Click here.

3 Click Properties.

Set
DOCUMENT PROPERTIES

Office automatically embeds certain document
properties, or metadata, such as the size of the
document, the date it was created, and so on, in the
document file. In addition to these default properties,
you can supply other document properties, which you
can then use to organize and identify your
documents, as well as search for documents at a
later date. For example, you can enter an author
name, a title, a subject, keywords, a category, status
information, and comments. You can also add custom
properties, such as the client name, department,
date completed, and even typist.

You can view certain document properties that are
recorded automatically in the Open or Save As dialog
box. To do so, simply click the document you want to
view in either dialog box, click the down arrow next
to Views, and then choose Details. To view properties
of a document that you yourself add, open the
document, click the Office button, click Prepare, and
click Properties.

11
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The Document Properties pane
appears.

4 Type the document properties
in their respective fields.

5 Type comments about the
document.

10
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6 Click here.

7 Click Advanced
Properties.66
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The document’s Properties dialog box
opens.

8 To create a custom document property,
click the Custom tab.

9 Type a name for the property.
Alternatively, click a name in the Name
list (here, Client is selected).

0 Click here and select the type of value the
custom property should contain — for
example, Text.

! Type the value for the document property
(here, the client’s name is used).

@ Click Add.

# Click OK.

The custom property is applied to the
document.
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Did You Know?
In addition to enabling you to
set custom properties, the
Properties dialog box also
enables you to see a summary
of the properties set, as well
as statistics about the
document, such as the page
count, word count, and even
whether the document has
been printed.

Cross-Platform!
Windows Vista users can
search using document
properties with the operating
system’s built-in search
function. If you use Windows
XP, however, you must first
download the Windows
Desktop Search tool from the
Microsoft Web site.

More Options!
To close the Document
Properties pane, click the
Close button in the pane’s
upper-right corner. You can
click the Cancel button to
close the Properties dialog box
without saving any changes.
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1 With the document you want to
check for sensitive information
open, click the Office button.

The Office menu opens.

2 Click here.

3 Click Inspect Document.

REMOVE SENSITIVE INFORMATION 

from your document
If you plan to share an Office document with others,
whether via e-mail or by some other method, you
might want to first ensure that the document is void
of personal, company, or other private information
that may be stored in the document’s metadata or in
the document itself.

This information might include comments, tracked
changes, or annotations; information about the

document’s author, status, category, keywords, and
so on; hidden information (such as text, rows,
columns, worksheets, or what have you) or content
marked “invisible”; server properties; custom XML
data; and more. (Note that if you remove hidden
data from a document, you might not be able to
restore it.) To locate and remove this data, you can
use the 2007 Office Document Inspector. 

11

33
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55

44

The Document Inspector dialog
box opens.

4 Ensure that the check box next
to each type of content you want
to inspect is checked.

5 Click Inspect.

12
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The Document
Inspector determines
whether any sensitive
information appears
in the document.

l If the Document
Inspector locates
sensitive information 
in the document, it
flags it.

6 Click Remove All.

66

77

13

l The Document Inspector removes the
sensitive information.

7 Click Close.
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Caution!
If you are not sure whether you want to remove the
information flagged by Document Inspector, cancel
the inspection and use the appropriate Office tools to
view the information. For example, if document
properties are flagged, then view the document
properties to see whether you want to eliminate
them from the document.

Caution!
You cannot undo the effects of removing information
with Document Inspector. You can, however, restore
the removed information by closing the document
without saving the changes made by the inspection
process.

Did You Know?
Be aware that the particulars of using Document
Inspector vary slightly depending on whether you are
using it in Word 2007, Excel 2007, or PowerPoint 2007.
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1 With the document you want to
encrypt open, click the Office
button.

ENCRYPT 

a document
If you are working on a document that contains
sensitive information, you might want to encrypt it.
That way, for someone to open the document and
view its contents, he or she will need to enter a
password, which you set. When you encrypt an Office
document, you set a password for it; to open the
document, the password is required. 

Be aware that if you forget the password, you will not
be able to open the document, even if you are the

person who encrypted it. For this reason, it is
imperative that you choose a password that you will
not forget, or that you write the password down and
keep it in a safe place. That said, the password
should not be easy for others to guess. The strongest
passwords contain at least eight characters and are
composed of a mixture of uppercase and lowercase
letters, numbers, and symbols. Avoid using common
passwords such as pet names, birth dates, and so on.

11

33

22

The Office menu opens.

2 Click here.

3 Click Encrypt Document.

14
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The Encrypt Document
dialog box opens.

4 Type the password you
want to assign to the
document.

5 Click OK.

55
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The Confirm Password dialog box opens.

6 Type the password again to confirm it.

7 Click OK.

Office encrypts the document.
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Apply It!
Open an encrypted document just as you would any
other document — for example, by double-clicking it.
When you do, Office displays the Password dialog
box; type the password and click OK.

Remove It!
To unencrypt a document, open it, click the Office
button, and click Save As. In the dialog box that
opens, click the Tools drop-down arrow and choose
General Options; then delete the password in the
Password to open field.
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SIGN A DOCUMENT

1 With the document you want
to sign open, click the Office
button.

The Office menu opens.

2 Click here.

3 Click Add a Digital Signature.

DIGITALLY SIGN
a document

To authenticate an Office document, you can add a
digital signature to it. First, however, you must
create a digital ID and have a current digital

certificate, which is a means of proving identity. A
digital certificate is issued by a certificate authority,
which is a trusted third-party entity. (If you do not
have a digital ID, you are prompted to create one as
you complete this task.)

A digital signature contains a message digest, which
contains a reduced version of the document’s

contents, and a private key, which is used to encrypt
the message digest on the signer’s computer. When
you sign a document, the encrypted version of the
message digest is appended to the document; the
digest is then decrypted by the recipient using the
public key, included in the digital certificate
associated with the signature. In this way, the
recipient can confirm the origin of the document and
that the contents of the document did not change
during transit.

11

33

66

22
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55

The Sign dialog box opens.

4 Optionally, type your reasons for
signing the document in the
Purpose for signing this
document box.

5 Click Sign.

The Signature Confirmation
dialog box opens.

6 Click OK.

The document is signed.

16
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VIEW A SIGNATURE

1 With the document
whose signature you
want to view open,
click the Office button.

The Office menu opens.

2 Click here.

3 Click View Signatures.

The Signatures pane
opens.

4 Click here.

5 Click Signature Details.

11
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The Signature Details dialog box opens.

l The signature is deemed valid.

6 Click View.

The Certificate dialog box opens.

l Information about the certificate appears
here.

7 Click OK.

8 Click Close.

The Signature Details dialog box closes.
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Important!
You are not required to obtain a digital certificate from a
certificate authority in order to create a digital ID and sign
your Office documents; instead, you can create your own.
To do so, click Create your own digital ID instead of Get a
digital ID from a Microsoft partner in the Get a Digital ID
dialog box, which is displayed automatically if no digital
ID is present on your computer. Then, in the Create a
Digital ID dialog box that appears, enter the requested
information — name, e-mail address, organization, and
location — and click Create. Note, however, that when
you share a file signed with a digital ID you created, it
cannot be authenticated by users on other machines.
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1 With the document you want
to mark as final open, click the
Office button.

Mark a document as  
FINAL

After you finish working on a document — that is,
you have proofread it and accepted any revisions
made with the Track Changes feature — you can
mark it as final. Marking a document as final makes
the file read-only, thereby preventing changes from
being made to the document. The document can,
however, be opened and read by others. (Note that
the file is read-only when opened by users whose
systems run Office 2007. If the document is saved in

Compatibility Mode and opened in an earlier version
of Office, the file will not open in read-only mode.) 

Marking a file as final is not a security feature.
That is, it does not permanently and irrevocably lock
the document to prevent further edits. Anyone with
access to the document can revoke the Mark as
Final status. Steps for revoking Mark as Final status
appear among the tips at the end of this section.

11

33

22

The Office menu opens.

2 Click here.

3 Click Mark as Final.

18
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Office notifies you that
the file will be marked
as final and saved.

4 Click OK.

44

55

19

Office describes the actions that have
been taken.

5 Click OK.

The document is marked as final.
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Did You Know?
If a document has been
marked as final, it
displays a special Mark
as Final icon along the
bottom of the screen.

Did You Know?
When a document is
marked as final, the
document’s Status
property changes to
Final. That means you
can search for the
document using that
status as a criterion.

Remove It!
You revoke the Mark
as Final status the
same way you apply it:
by clicking the Office
button, clicking Prepare,
and clicking Mark as
Final. Revoking Marked
as Final status means
the document can again
be edited.
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1 Click the Office button.

2 Click Program Name Options.

Enable
SMART TAGS

Several Office programs support the use of smart
tags, which are labels that indicate that the
document contains data of a particular type, and
enable you to perform certain tasks using that data. 

For example, if Office detects a name in your
document, it can display a smart tag indicator, a
purple dotted line. You can click the smart tag
indicator to open the contact record in Outlook that
is associated with that name, add the name to your
Outlook contacts, schedule a meeting with the
person, or insert the person’s address. (The precise

options available to you when you click the smart tag
indicator depend on what type of data is detected.)

To use smart tags, you must first enable them. In
addition to using the smart tags that are available
within Office, you can obtain additional smart tags
from Microsoft as well as from third-party companies.

Note that you can embed smart tags in Excel and
PowerPoint documents; that way, others who open
the document on their own computers can view the
smart tags.

11

33

22

44

The Program Name Options
window opens.

3 If you are enabling smart tags
for Word, click Advanced.

4 Click Show Smart Tags 
( changes to ). 

Note: If you are in Excel or
PowerPoint, click Add-Ins instead
of Advanced, and click the Manage
drop-down arrow, click Smart Tags,
and click Go; then, choose the
desired options in the dialog box
that appears.

20
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5 Click Add-Ins.

6 Click the Manage 
drop-down arrow.

7 Click Smart Tags.

8 Click Go.
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The AutoCorrect dialog box opens.

9 Click here to label text with Smart Tags
( changes to ).

0 Click each type of data you want to flag
with smart tags ( changes to ).

! If you are enabling smart tags for Word,
click Show Smart Tag Actions buttons 
( changes to ).

@ Click OK.

Office enables smart tags in the program
that is currently open.
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Check It Out!
To obtain additional smart tags, open
the AutoCorrect dialog box and click
More Smart Tags. Office launches a
special page on Microsoft Office Online
that enables you to access links to
additional smart tags created by
Microsoft as well as by third-party
software vendors. You can also find
links to tools for building your own
smart tags.

More Options!
Similar to smart tags are AutoCorrect
and Paste Options tools. AutoCorrect
works by displaying an AutoCorrect
button anytime an Office program
corrects text that you enter; click the
button to undo or adjust the correction.
Paste Options displays a Paste button
when you paste data into a document;
click it to specify how you want the
content pasted in.
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1 Click the arrow to the right of
the Quick Access toolbar.

Office displays the Customize
Quick Access Toolbar menu.

2 Click the command you want
to add to the toolbar.

Customize the 
QUICK ACCESS TOOLBAR

The Quick Access toolbar provides easy access to
often-used commands such as Save and Undo. You
can customize the Quick Access toolbar to change
which commands are available. 

Office enables you to add commands to the Quick
Access toolbar three different ways. One is to select
the desired command from the Customize Quick
Access Toolbar menu. Another is to use the Program

Name Options dialog box. Finally, you can simply

right-click the command you want to add in the
Ribbon and click Add to Quick Access Toolbar. 

In addition to adding commands to the Quick Access
toolbar, you can also move it from its default spot
above the Ribbon to a spot below the Ribbon. To do
so, click the arrow in the Quick Access toolbar and
click Show Below the Ribbon from the menu that
appears.

11

22

33

44

l A button for the selected
command appears.

In this example, Spelling &
Grammar was selected.

3 If you do not find the command
you want to add, click the arrow
to the right of the Quick Access
toolbar.

4 Click More Commands.

22
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The Program Name
Options window opens
with Quick Access toolbar
options displayed.

5 In the window’s left pane,
click the command you
want to add.

Note: If the command you
want to add is not displayed,
click the Choose commands
from drop-down arrow and
select All Commands.

6 Click Add.

l The command is added
to window’s right pane.

7 Click OK.

66

55

77
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l A button for the selected command
appears.

In this example, Track Changes was
selected.

Chapter 1: Maximize the Power of Office 2007

Did You Know?
You can add groups of
commands in the Ribbon to the
Quick Access toolbar. To do so,
right-click the group name in the
Ribbon and click Add to Quick
Access Toolbar. The group is
stored under a single button;
click the arrow next to the
button to reveal the available
commands in the group.

Did You Know?
To apply the change to the
Quick Access toolbar to the
current document only, click
the Customize Quick Access
Toolbar drop-down arrow in
the Program Name Options
window and choose For
Document Name.
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MINIMIZE THE RIBBON

1 Click the arrow button to the
right of the Quick Access toolbar.

Office displays the Customize
Quick Access Toolbar menu.

2 Click Minimize the Ribbon.

Customize the 
RIBBON

In lieu of using the traditional menu system and
toolbars, Office 2007 features what Microsoft calls
the Ribbon. The Ribbon is designed to enable you to
find the command necessary to complete a task more
quickly and more intuitively than the menus of old.

To this end, the Ribbon groups related commands
together, placing them under clickable tabs. Each tab
pertains to a certain type of task, such as formatting
text, inserting items into a document, laying out a

page, reviewing a document, and so on. The tabs
displayed depend on which Office program is open,
and what type of task is being performed.

If you feel the Ribbon consumes too much space in
your Office windows, you can minimize it, displaying
it in full only when it is needed. 

If you prefer, you can access the commands
displayed in the Ribbon using your keyboard.

11

22

Office adds a check mark next to
the Minimize the Ribbon
command and minimizes the
Ribbon.

l Notice that the Ribbon’s tabs
are still present; to reveal options
in a tab, click it; to hide them
again, click the tab a second
time.

24

03_118702 ch01.qxp  10/31/07  6:04 PM  Page 24



REDISPLAY THE RIBBON

1 Click the arrow to the
right of the Quick
Access toolbar.

Office displays the
Customize Quick Access
Toolbar menu.

2 Click Minimize the
Ribbon.

11

22

25

Office removes the check mark next to
the Minimize the Ribbon command and
displays the Ribbon in full.
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Try This!
To quickly minimize the Ribbon,
double-click any of its tabs. To
redisplay it, double-click a tab a
second time.

More Options!
Just as the menus in older versions of Microsoft Office
supported the use of keyboard shortcuts to execute various
commands, so, too, does the Ribbon. To see what keyboard
shortcuts apply, press and release the Alt key on your
keyboard; Office shows key tips, which denote the key used
in conjunction with the Alt key in the keyboard shortcut.
(Note that pressing the key indicated by the key tip may
reveal more key tips. For example, you might press Alt+N to
switch to the Insert tab; when you do, Office displays key tips
for the various commands located on that tab.)
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1 Click the Office button.

2 Click Program Name Options.

Change the 
SAVE SETTINGS
By default, Office saves your documents in your
Documents folder (or, if you are using a version of
Windows that precedes Windows Vista, the My
Documents folder). You may find, however, that
another folder is more suitable. For example, if you
only create PowerPoint presentations for a particular
client, you might configure Office to save PowerPoint
files you create in the folder you have created for
that client by default.

In addition to changing where Office stores your
Word, Excel, PowerPoint, and other Office files by
default, you can also specify what file extension

should be used. For example, suppose your Word
files should be backward compatible by default. In
that case, you can opt to save all files you create
using Office 2007 in Compatibility Mode (that is, in
Word 97–2003 format).

Assuming you want Office to auto-save your
documents (recommended), you can also indicate
how frequently the auto-save operation should occur.
Auto-saving too frequently can slow your computer;
auto-saving too infrequently can cause you to lose
more data in the event of a system crash.

11
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The Program Name Options
window opens.

3 Click Save.

4 Click here and select the desired
default file format.

5 Click here to save AutoRecover
information ( changes to ).

6 Click the up or down arrow to
increase or decrease the time
between each auto-save
operation.

7 Click Browse.

26
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The Modify Location
dialog box opens.

8 Open the folder in
which you want to save
documents created by
this Office program by
default.

9 Click OK.

88

00

99
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l The folder you chose appears in the
Default file location field.

0 Click OK.

The Program Name Options window
closes, and your changes are applied.

Chapter 1: Maximize the Power of Office 2007

More Options!
To ensure that others who view your
Word or PowerPoint document see it with
the correct fonts, select the Embed fonts
in the file check box in the Program
Name Options window’s Save screen. To
reduce the size of your file, opt to embed
font information for those characters used
in the document only, and to not embed
common system fonts. (This option is
available for Word only.)

Try This!
If you want to change the author name
that is associated with your documents,
open the Program Name Options
window and, in the Popular screen, type
the desired name in the User Name field.
Optionally, if using Word or PowerPoint,
you can also change the author initials.
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